
Bhunaksha 3.0 User Guide 

 

 

 
 
 
 
 

 
 
 

 

Bhunaksha 3.0 User Guide  

 
1 



Bhunaksha 3.0 User Guide 

 

 

Bhunaksha 3.0 User Guide 
 

 
1. About Bhunaksha 
2. Features 
3. Bhunaksha Architecture 

3.1 Centralized Architecture 
3.2 Distributed architecture 
3.3 Open source application and libraries used in Bhunaksha 

4. System Requirements 
4.1 System Requirements Server 
4.2 System Requirements Client 

5. Installation 
5.1 Building and Downloading 
5.2 Server 
5.3 Client 

5.3.1 Bhunaksha Desktop Client 
5.3.2 Bhunaksha Browser Client 
5.3.3 Bhunaksha Mobile App 

6. Styling Map 
6.1 Style Templates 
6.2 Symbols 
6.3 Style Editor 

6.3.1 Point Symbolizer Editor 
6.4 Defining Styles for Map 

6.4.1 Common map display styles. 
6.4.2 Layer Styles 
6.4.3 Theme Styles 

7. Importing Shape File 
7.1 Bulk Import 
7.2  Individual Import 

7.2.1 Import Plots (SHP) 
7.2.2 Import Layer (SHP) 

7.3  Customized Import for States 
7.3.1  Jharkhand 
7.3.2  Chhattisgarh 

8. Viewing and Correcting Shape files 
9. Validating Shape Files 

9.1 Custom validations of shape files. 
9.1.1  Khasara Number and area comparison in shape file and textual database 
9.1.2 Validation of Digitized data as per Data Structure Design format (DDSF) - Bihar 

 
2 



Bhunaksha 3.0 User Guide 

 

 

10. Village  Map View 
10.1 Village Map View 
10.2 Customized Village Map for States 
10.2.1 Maharashtra 

11. Plot Report 
12. Village Map Printing 

12.1 Village Map Printing 
12.2 Customized Village Map for States 
12.2.1 Maharashtra 

13. Splitting Plot (Mutation) 
13.1 Division Tool Set 
13.2 Free Hand Drawing 
13.3 Distance Angle Method 
13.4 Distance Direction Method 
13.5 Arc Method (Adjacent Side) 
13.6 Arc Method (Opposite Side) 
13.7 Point Measurement Method 
13.8 Straight Line Division 
13.9 Area Division 
13.10 Division with help of background image 
13.11 Division using ETS Data 

14. Multiple Plot Splitting (Cutting Road/Canal) 
15. Merging plots 
16. Creating map using FMB and Tippon 

16.1 Diagonal and Offset / Simple Triangulation System. 
16.2 Bombay Style 
16.3 Viewing/ Printing Map created from FMB. 

17. Composing Survey Data 
18. Plot Comparison Reports 

18.1  Plots Present in map missing in ROR 
18.2 Plots Present in ROR missing in Map 
18.3 Duplicate Plot numbers in map 

19. Mutation Report 
20. Export Map as Shape file 

20.1 Bulk Export 
20.2 Individual Export 

18.2.1  Export Plots (SHP) 
21. Embedding Plot Map in ROR report. 
22. Audit Trail 
23. Plot Info 
24. Imported Villages Report 
25. Data Transfer to server 
26. Unimported Villages Report 

 
3 



Bhunaksha 3.0 User Guide 

 

 

27. Data Migration from previous version 
28. Georeferencing Village Maps 
29. Custom Services 

29.1  Himachal Pradesh 
29.1.1   PlotImage Service 
29.1.2  Neigboring Plots 

30. Bhunaksha Mobile App 
31. Bhunaksha FAQ 
32 Annexure 

32.1 Installation of Postgresql & Postgis 
32.1.1 On Ubuntu 14.04 LTS. 
32.1.2 On Windows 

32.2 Load balancing and High availability Clustering setup for Tomcat 
33. Configuring Bhunaksha Demo application 
34. Downloads 

 

  

 
4 



Bhunaksha 3.0 User Guide 

 

 

1. About Bhunaksha 
 
Introduction 
 
The Government of India have decided to implement the Centrally-Sponsored scheme in            
the vector of the National Land Records Modernization Programme (NLRMP) by merging            
two existing Centrally-Sponsored Schemes of computerization of Land Records (CLR) and           
Strengthening of Revenue Administration and Updating of Land Records (SRA&ULR) in the            
Department of Land Resources(DoLR), Ministry of Rural Development. The integrated          
programme would modernize management of land records, minimize scope of land           
disputes, enhance transparency in the land records maintenance system, and facilitate           
moving eventually towards guaranteed conclusive titles to immovable properties in the           
country. The major components of the programme are computerization of all land records             
and integration of textual and spatial records and mutations, survey/re-survey and updation            
of all survey & settlement records including creation of original cadastral records wherever             
necessary, computerization of registration, development of core GIS and capacity building.           
This document outlines detailed requirements for cadastral mapping solution and the           
integration of ROR and cadastral maps under NLRMP. 
 
The scope of the system is to facilitate end to end solution for cadastral mapping starting                
from digital verification of raster and vector data of cadastral maps, its integration with              
Records of Rights (RoR) and services such as mutation, updation, distribution of RoR and              
map covering the requirements of NLRMP project in G2G and G2C domain. During the              
process of development the software will incorporate all organization flows and process of             
Land Revenue System. The software will be deployed in the tehsils/taluks in the country. 
 
In present scope of work, cadastral maps are maintained within village boundaries with             
proper village index defining association, direction and orientation among plots          
constituting the village. This is to ensure “whole to part approach” and keeping errors              
confined to village boundaries.  
 
Bhunaksha is a cadastral mapping software developed by NIC using Open source            
applications and libraries to facilitate management of digitized cadastral maps. With proper            
customization Bhunaksha can be integrated with existing Land Records application of any            
states that deals with textual data. Back end database Postgresql with Postgis spatial             
module is used for storing geometry and spatial attributes of plots and other features.              
Bhunaksha talks to other external ROR database which are mostly in MS Sql Server in               
implemented states. ROR database can be virtually in any RDBMS. 
 
The scanning, digitization, verification of cadastral maps are the pre-processes and input to             
Bhunaksha applica ​tion. 
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For overcoming diverse structure of ROR database in different states Bhunaksha defines            
certain interfaces for talking with ROR database. The interfaces are implemented           
differently for different states based on the structure of that state’s ROR database. In this               
way the same Bhunaksha application workbench can be used for any state just by plugging               
the particular state's implementation of ROR interfaces. 
 

2. Features 
 

1. Developed using Free and Open source software.  
2. Works in Windows and Linux  
3. Centralized and Distributed architecture. 
4. Web, Desktop and Mobile apps available.  
5. Responsive web rendering for smaller screens. 
6. Plugin architecture to facilitate integration with any state’s ROR/Master database. 
7. A plot can be divided into multiple subdivisions in a single mutation 
8. Multiple methods for creating division lines. 
9. Grid and Background image can be used  to help in drawing division lines.  
10. Multiple plots can be divided in a single operation for cutting road/canal etc. 
11. History and Audit trail of division is maintained in the software. 
12. Distance measurement and calculation takes into consideration initial scale and local 

units 
13. Plot map and Village map can be displayed and printed to any scale.  
14. Vector printing of maps. 
15. SLD based styling of plot and layers. 
16. Query based thematic maps can be defined by user. 
17. Bulk import of Shape files and ADF files. 
18. Maps can be generated from Survey data (LandXML) data and FMB  
19. Validation reports for comparing data in ROR database and digitized map files  
20. Helps to correct geometry errors in Shape file. 
21. Adapts to the authentication and authorization features of ROR database users.  
22. Online Georeferencing tools for  legacy maps. 
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3. Bhunaksha Architecture 
 
Bhunaksha is designed to work in a centralized environment and distributed environment.  
 

3.1 Centralized Architecture 
 

 
In centralized architecture the core application and database resides on an array of centralised              
servers. The application can be accessed through browser or Bhunaksha desktop client. The             
desktop client consumes REST services provided by the server application. Some of the robust              
features which cannot be implemented with limited facilities of browsers are implemented in             
Desktop client application alone. Services which are to be used directly by public has been               
completely implemented in browser client. This setup will be feasible only when there is              
remarkably high bandwidth connectivity among the department offices and powerful array of            
servers. The application can also be accessed via the mobile client which provides some mobile               
friendly features.  
 

3.2 Distributed architecture 
 
Bhunaksha can also can be setup to work in a distributed architecture. In this case Bhunaksha 
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database can be installed on district or sub district (Tehsils) servers. Desktop applications in 
LAN can connect to this server. All map management, plot division etc. can be performed at 
respective office unit with the desktop application.  Data can be merged to central server system 
installed at state data centers in a planned schedule. In this case Bhunaksha installed on central 
server can be used for view purpose.  This architecture can be used even if connectivity to 
central server is weak. 
 

 
 

3.3 Open source application and libraries used in Bhunaksha 
 
Bhunaksha is developed using the power of some of the world’s most advanced and popular               
open source applications and libraries mentioned below.  
 
1. Java  
Java is a computer programming language that is concurrent, class-based, object-oriented, and            
specifically designed to have as few implementation dependencies as possible. It is intended to              
let application developers "write once, run anywhere", meaning that code that runs on one              
platform does not need to be recompiled to run on another. Bhunaksha application is developed               
in Java language. 
 
2. Postgresql and Postgis 
PostgreSQL is a powerful, open source object-relational database system. As a database            
server, its primary function is to store data, securely and supporting best practices, and retrieve               
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it later, as requested by other software applications. PostgreSQL prides itself in standards             
compliance. Its SQL implementation strongly conforms to the ANSI-SQL:2008 standard.  
 
PostGIS is a spatial database extender for PostgreSQL database. It adds support for             
geographic objects allowing location queries to be run in SQL. In addition to basic location               
awareness, PostGIS offers many features rarely found in other competing spatial databases            
such as Oracle Locator/Spatial and SQL Server. 
 
3. GeoTools 
GeoTools is an open source (LGPL) Java code library which provides standards compliant             
methods for the manipulation of geospatial data, to implement Geographic Information Systems            
(GIS). The GeoTools library implements Open Geospatial Consortium (OGC) specifications as           
they are developed. 
 
4. Tomcat Server 
Apache Tomcat is an open source web server and servlet container developed by the Apache               
Software Foundation (ASF). Tomcat implements the Java Servlet and the JavaServer Pages            
(JSP) specifications, and provides a "pure Java" HTTP web server environment for Java code to               
run in. 
 
5. Jasperreports 
JasperReports is an open source Java reporting tool that can write to a variety of targets, such                 
as: screen, a printer, into PDF, HTML, Microsoft Excel, RTF, ODT, Comma-separated values or              
XML files. 
 
6. OpenLayers 
OpenLayers is an open source JavaScript library for displaying map data in web browsers. It               
provides an API for building rich web-based geographic applications similar to Google Maps and              
Bing Maps. 
 

 

4. System Requirements 

4.1 System Requirements Server 
 
CPU: ​4 cores, each >= 2GHz 
Disk: ​250GB Initial, regular monitoring and backups recommended based on usage. 
Memory: ​4 GB RAM 
Operating System: 
(a) Windows 7  

or 
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(b) Linux (CentOS, Red Hat (RHEL), or Ubuntu.) 
Java: ​7+ (Oracle JRE) 
Application Server: ​Tomcat 7 
Database:  
(1) Postgresql 9.0+, Postgis 1.5+ (Can be on separate Server) 
(2) Connectivity to ROR database 
 

4.2 System Requirements Client 
 
Operating System: 
(a) Windows 7 + 

or 
(b) Linux (CentOS, Red Hat (RHEL), or Ubuntu.) 
Browser:​ Firefox or Google Chrome 
Java:​ Oracle JRE 7+ 
 

5. Installation 
Install only the relevant applications based on the architecture you have planned. Server             
installation will be needed on central server only. In a distributed architecture normally you will               
need database on the Tehsil Server and desktop applications on client machines.  
 

5.1 Building and Downloading 
 
Bhunaksha application can be downloaded from Bhunaksha website [eg: 
http://10.248.31.20/bhunaksha/​] . 
Download System is tightly integrated with the source code repository (Subversion). You can 
login by selecting your State and providing proper user ID and password. Once logged in you 
will be able to view the changes made to source code and ​Build​ a binary based on the latest 
source code. Bundle of already built binary files can be downloaded for Web Deployment 
(WAR) and Desktop deployment. A backup of existing binaries will be created on building new 
source code. Download statistics will be available for the compiled binary and backup copy. 
You can also review status of bugs from bug tracking system in this page.  
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Details of Downloadable files 

(1) WAR :- Web archive. This can be installed in Apache Tomcat Server. This application 
does not have browser based editing features. After installing this application, user can 
login and download Bhunaksha Desktop Client from  the installed application to perform 
map editing, shapefile import etc. 

(2) WAR [Experimental browser editing] :- This web archive has browser based map editing 
features along with all other features available in above WAR. 

(3) Desktop Client For Windows :- Bhunaksha Desktop Client bundled with Java Runtime 
Environment (JRE) for windows. This desktop client can be used either to work offline 
with local database or to connect with a live Bhunaksha server. 

(4) Desktop Client (Platform independent). This is as the bundle described in (3) without 
JRE. To run this desktop client you will need to install latest JRE separately. These 
compiled Jar files can be executed in Windows or Linux. 

(5) Pre configured JRE for Windows :- This is a version of JRE which can be used for 
running Bhunaksha Desktop client. This JRE has required fonts bundled with it. This can 
be merged with Desktop client files downloaded from (4) or from bhunaksha web 
application to resolve missing font issues.  
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(6) DB Configuration File Creator :-  This is a small independent application which can be 
used on server to create Bhunaksha GIS database and configuration file 
(bhunaksha.properties) which is needed on server before installing Bhunaksha web 
application (WAR).  

 
 
 

5.2 Server 
 
(1) Install postgresql and postgis. Test connectivity from server 
(2) Test connectivity to ROR database. 
(3) Install Java 
(4) Install and start Tomcat  
(5) Create Bhunaksha GIS database on server using DB Configuration File Creator application             
described in download section 5.1 (6) 

 

 
12 



Bhunaksha 3.0 User Guide 

 

 

(6) Create bhunaksha.properties using DB Configuration File Creator application described in           
download section 5.1 (6) 

 
(7) Copy bhunaksha.properties  to conf folder of tomcat. 
(8) Add maxPostSize="6666666" attribute under the <Connector> tag in “server.xml” found           
under the /tomcat/conf/ directory.  
(9) Deploy Bhunaksha web application by copying war file to webapps folder. 
(10) Test Bhunaksha web application by accessing its url on browser. [eg URL:             
http://localhost:8080/bhunaksha ]. Actual URL domain or Ip address, port, path with differ based             
on your installation of your server and tomcat server. 
You can login to bhunaksha web application by selecting your location, user id and password.  
User ID and password of users are usually the same as linked ROR application.  
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After logging in you can download Desktop Client from Download menu. The desktop client can               
be used for importing shape files, printing, editing and other map management activities  
 
Maps will be visible in Bhunaksha once you import shapefile using desktop client connected to               
bhunaksha server or after creating map using FMB or other means. 
 

 
 
 

5.3 Client 
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A client machine can connect to Bhunaksha server application through Bhunaksha Desktop            
client or browser. Bhunaksha Desktop client application has more robust map printing and             
composing capabilities compared to browser based application. 
 

5.3.1 Bhunaksha Desktop Client 
 
On Windows machines Unzip BhunakshaDesktop application and run Bhunaksha.exe. On linux           
machines platform specific launcher can be invoked. On first run it will ask for server URL of                 
bhunaksha server or parameters to connect to Bhunaksha database.  
 

 
 
If Remote Server option is selected then you will be able to connect to a remote server where                  
Bhunaksha Server application is installed by providing it’s URL.  
 
Otherwise you can provide the database details for connecting to Bhunaksha DB in postgresql              
and Textual database. Both the databases should have proper permissions to connect from the              
system where Desktop application is being configured. A new Bhunaksha DB can be created              
and initialized with tables and structures for running fresh Bhunaksha from this screen itself.  
Test the connections and click OK button to save the connection details. The saved settings can                
be changed from menu Settings -> Server Settings. 
 

5.3.2 Bhunaksha Browser Client 
 
The public site of Bhunaksha can be accessed using normal browser without installing any extra               
software. We recommend open source browsers like Firefox or Chrome. 
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For officials who will be performing administrative tasks, map printing, map management,            
division etc. will need extra software to be installed. These tasks can be performed either in                
browser or using Bhunaksha desktop application.  
 
 

5.3.3 Bhunaksha Mobile App 
 
The Bhunaksha Mobile App is available for Android phones. Install the APK file on android               
mobile or tablets. The App requires the network access permission for the device. After              
installation, the server url can be updated via settings in the app menu. 

6. Styling Map 
 
Bhunaksha version 3 introduces limitless map styling features using Styled Layer Descriptor            
(SLD), an XML schema specified by the Open Geospatial Consortium (OGC) for describing the              
appearance of map layers. SLD is an XML-based markup language and is very powerful,              
although somewhat complex. Detailed information regarding SDL can be checked on the            
following link: ​http://docs.geoserver.org/stable/en/user/styling/sld-cookbook/ 
In Bhunaksha it is possible to customize appearance of map displayed at any part of the                
application like village map display, plot selection, layers, themes, plot report, village report etc. 
Style of map can be customized from admin login of Desktop application. Bhunaksha comes              
with a lot of predefined style templates and symbols which can be applied and altered during                
map styling.  
The Symbolizer part of SLD XML can be used in Bhunaksha. A handy SLD editor was                
developed for easy editing of SLD XML fragments. 
 
 

6.1 Style Templates 
 
Style templates are predefined SLD fragments which can be copied and customized when             
styling a map. Templates will have a name and will be of category Polygon, Line or Points. For                  
managing Style Templates login as admin user in Desktop application and invoke the module              
from menu Admin -> Style Template Manager.  
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6.2 Symbols 
 
Symbols are graphic images which can be used for styling any point layer. Bhunaksha uses the                
concept of named symbols instead of hardcoding the image path. Images used as symbols can               
be a vector image (SVG) or any raster images (jpg, png, gif). It is recommended to used vector                  
image for symbols since it can be scaled without losing clarity during map styling. The library of                 
symbols can be managed from menu Admin -> Manage Symbols after loging in as admin user                
in Desktop application. You will be able to choose these symbols when defining a point               
symbolizer while styling a map layer. 
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6.3 Style Editor 
 
SLD editor is a tool for easy editing of SLD XML fragments in Bhunaksha. This editor will appear                  
in all sections like layer manager for setting the style of map layer.  
 

 
SLD Design mode 

 
SLD Source mode 
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It is possible to create a map style by copying from already defined style template or typing the                  
xml fragment in the source tab of the editor. The Design tab will show the editable part of SLD                   
XML with suitable edit controls. For example in design tab colour it will be possible to edit color                  
using a color picker.  
 

6.3.1 Point Symbolizer Editor 
 
Point Symbolizer editing in the SLD editor needs to be elaborated more.  
A point symbolizer can be created mainly in three ways. 
(i) From well known text like circle, square, trangle, star, cross etc. 
(ii) From ttf fonts like Webdings which is a massive symbol library 
(iii) From image symbols. 
 
The SLD editor pops up selectable tool for selecting well known symbols and ttf font based                
symbols. For ttf font based symbols please make sure that the font is available on server also.  
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For image based symbols the images stored in symbol library can be selected from an inline                
dropdown 
 
 

 
 
 

6.4 Defining Styles for Map 
 
Style of map can be set from different sections of Bhunaksha.  
 

6.4.1 Common map display styles. 
 
Common map styles like village map, plot selection, plot print out , default styles, some               
predefined layers etc. can be set from menu Admin -> Application settings -> Map Styling (tab).                
From this section style can be set using the above mentioned style editor.  
 
 

6.4.2 Layer Styles 
 
Layers like road, river which are imported to bhunaksha can be managed from menu Admin ->                
Manage layers. It is possible to define code, name, and style of all imported layers from this                 
section. New layers can be created and display style can be defined from this section. 
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6.4.3 Theme Styles 
 
A thematic map is a map that focuses on a specific theme or subject area, whereas in a general                   
map the variety of phenomena—geological, geographical, political. In bhunaksha a named           
theme and its style can be defined from menu Admin -> Manage  Themes.  
The theme can be defined based on a query which can execute either to ROR database or                 
Bhunaksha database. The query should return a set of plot numbers or a set of geometry.  

 
21 



Bhunaksha 3.0 User Guide 

 

 

 
 

7. Importing Shape File 
 
Import module is intended for importing geometry and attribute data from external file to              
Postgresql (Postgis) database. During this process the plots and layers will get linked to the               
village code of ROR data. Plot numbers will get linked to plot numbers in ROR data. Bhunaksha                 
can import data from Shape files.  
There are mainly two modules for importing shape files to bhunaksha 
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7.1 Bulk Import 
 
Bulk import option can be used for importing a set of files in a single go. For using this module                    
login into Desktop application as user and invoke the option from File -> Bulk Import.  

 
 
Bulk import will be possible only if the shape files are named in a standard way using codes                  
from the selection hierarchy till village/sheet. The file name format, and key attribute fields which               
store plot number, layer code etc. will have to be configured from Admin -> Application Settings                
as admin user.  
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Shape files containing geometry errors, having unrecognizable file name mor missing the            
mandatory attributes will be rejected while importing. 

 
 

7.2  Individual Import 
 
Plot and layer shape files can be imported individually into bhunaksha if naming pattern used               
for shape files does not support the bulk import standards. Individual files can be imported from                
the following options. 
 

7.2.1 Import Plots (SHP) 
 
This module can be used for importing plot shape files.  
 
 
 

1. Browse the shape file containing plots. 
2. Select Plot No (Khasara) column from shape file. 
3. Select the village to which the Shape File belongs. 
4. Type sheet no or other map type code associated with the shape file if present. 
5. Type Scale factor if the measurements in shape file is different from that of ground. 

(In almost all states 1 unit in shape file corresponds to 1 meter(unit) on ground. 
In case of Uttar Pradesh 1 unit in shape file was equal to 1 unit on printed paper map                   
which is in 1:4000 scale. So UP has to set scale factor 4000. In case of Himachal units                  
on ground is in Karam and digitization is done in centimeters and map is printed by                
scaling each inch to some karam. HP has to set scale factor 15.75 if map is 1 inch: 40                   
karam. 
1 inch : 40 karam 
1 unit in digitized shape corresponds to 1 cm 
So: 
2.54 Unit : 40 Karam. 
1 Unit : 40/2.54 = 15.748031496 
 Scale factor is 15.75 approx.) 

 
6. Click Import to import plots from shape file to Postgres database and to attach it with the                 

selected village. 
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7.2.2 Import Layer (SHP) 
 
This module can be used for importing layers other than plots to bhunaksha. The layers can be                 
either polygon, line or points and will signify some features on ground like well, road, diver,                
temple etc. Individual layer codes are used for identifying layers. Layer codes can be created               
from Admin -> Manage layer as admin login. The layer codes can also be specified in an                 
attribute of the shape file.  
 
 
 
 

1. Browse shape file containing the layers. 
2. Select layer 

You can manage the master of layers from Manage Layers button or by selecting              
Manage Layers from file menu. If different layers are digitized in different shape files then               
select the layer to which the chosen shape file belongs. If more than 1 layer is merged                 
into a single file and there is a layer code attribute in shape file to differentiate the layers                  
then you can select (Auto) from the Layer combo box. If (Auto) is selected then it will also                  
ask for selecting the field containing layer code. During (Auto) import if layers with the               
same code in shape file are not created from “Manage Layer” then it will automatically               
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create the layer master for the codes in shape file with some default theme. Later on you                 
can go to Manage Layer and update the actual theme. 

 
3. Type Skip codes if needed. 

In some states it is noticed that plots and other polygon features were merged in a single                 
shape file. For eg. In Himachal the Polygon shape file had plots and other layers like                
River, Road etc. Plots were having feature code “PA”. These plots can be skipped during               
layer import. For skipping them PA can be typed in Skip code field. If there is more than 1                   
codes to be skipped then they can be typed separated by comma with out space. 

 
4. Select village to which the layer belongs 
5. Click Import button 

 
 

 
 

7.3  Customized Import for States  
 

7.3.1  Jharkhand 
      

District, Circle, Village codes of Textual (ROR) database is different from codes used for naming 
the shape files. Both the codes will have to be mapped before performing import in order to link 
actual shape file with the village code. 
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To perform the mapping use RoR-GIS mapping panel under File menu ‘​File --> RoR-GIS 
Mapping’. 
 

    
1. Clicking ‘Show mapping data’ button will list the village code present in ROR database 

and it’s corresponding Digitization code if mapping is already saved.    
 

Digitization code is the shape file name for a village. (eg: R015010011.shp  for ​सगंडीह 
village) 

 
2. Edit the digitization codes and save the mapping table.  
3. Open Bulk Import menu item from File menu to perform bulk import of shape files. 

Working of this module is similar to Bulk Import operation described above. 
 

7.3.2  Chhattisgarh 
 
Chhattisgarh state has digitized data in Arc Info binary (ADF) file format. Bhunaksha has a state 
specific module for importing ADF files.  
For importing ADF files GDAL library will have to be installed and the installation folder will have 
to be set as System Path.  
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Browse the parent folder containing ADF files, Select the layers to be imported, Select the folder 
name of ADF file corresponding to the listed village name and click Import button to start 
importing the data.  
 

8. Viewing and Correcting Shape files 
 
Shape files can be opened and viewed from menu Admin -> View Map File from admin login                 
and Reports -> View map file in user login in the desktop version. It is possible to view geometry                   
errors and all existing attribute values of shape file from this window. Geometry errors will be                
listed as a column in the attribute table. The map can be viewed in any colour and overlapping                  
any of the attributes as label. 
 
It is possible to fix some common geometry errors like Self-Intersection error and rename              
attribute column names from this window. Shape files can be exported as a new shape file after                 
fixing errors and renaming attribute names from the toolbar icon ‘Export Shape File (Fix Errors)’. 
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(Export Shape file by fixing Self-Intersection error and renaming attribute names) 
 
 
 

9. Validating Shape Files 
 
Shape files which are initial output of digitisation can be validated for required fields and               
correctness of geometry in Bhunaksha. Shape file validation checking module can be opened             
from menu File -> Validate Shape file in Desktop client. This module will check whether the set                 
of shape files pertain to certain predefined conditions so as to import in Bhunaksha.  
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Result of validation will be displayed in a grid format which can be printed or exported as excel                  
file.  
 

 
 

9.1 Custom validations of shape files. 
 
Advanced shape file validation reports are available in Bhunaksha as per special requirements             
from states. 
 

9.1.1  Khasara Number and area comparison in shape file and textual database 
 
Bhunaksha has advanced shape file validation tools for states like Haryana. There is detailed              
comparison reports of plot numbers, and area of polygons in digitized shape file and ROR               
(Textual database)  
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(Area comparison report) 
 

 
(Plot comparison report) 
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9.1.2 Validation of Digitized data as per Data Structure Design format (DDSF) - 
Bihar 
This validation module is a customized validation tool which will check output of digitization for               
whether it pertains to the standards and codes mentioned in the data structure design format               
which is communicated to digitizing agencies. This report will check for the presence of files,               
fields in digitized files, codes used in specified fields and other geometry errors.  
A detailed analysis report will be generated for folders and files present at a specified location.  
 

 

 
(Village Wise Validation Report) 
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10. Village  Map View 

10.1 Village Map View 
 
Village map view is the default view of Bhunaksha when invoked through web url by public, after                 
logging in as user in web or desktop application.  

 
(Desktop  View) 
 

 
(Web View) 
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(Mobile view)  
 
 
It is possible to select any plot by either clicking on the plot or typing ‘Plot No’. Owner details                   
and ROR information will be displayed when a plot is selected. All plots belonging to owner of                 
selected plot can also be displayed if the details is available in linked ROR database. It is                 
possible to overlay imported layers and themes on the village map by selecting particular layer               
or theme. Modules like Plot Report (Printable Plot Map), Split Plot, Plot Info can be invoked                
directly from this section after selecting a plot. To invoke the modules in Desktop Client select                
the plot and invoke the module from the ‘More..’ sub menu adjacent to Plot No. field.  
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10.2 Customized Village Map for States  

     10.2.1 Maharashtra 

 
This Village map is customized for state maharashtra.This village map having all the the              
functionality of default village map with some extra functionality like. 

1. Search Option:- we can search the following attributes in map by entering the following              
value in text boxes . 

a. Survey Number 
b. Hissa Number 
c. M.R Number 

2. Search Result :- The village map contains the search attributes appear in search result              
Table. By click on any row in Search result table you can view the map which contain the                  
search attribute. 

Example: See the above figure we enter the attribute “Survey No. ” 110 then click on “Search                 
Button” ,then click on click on row of Search result table village map appear. 
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11. Plot Report 
 
Plot Report is a printable report which will have map of an area containing the plot. It will have                   
location and owner information along with the map. It is possible to generate the map to any                 
scale and overlaying layers.  
The quality of map print has been improved from previous version of Bhunaksha. Vector              
printing is introduced from Bhunaksha 3.0 onwards. 
This report will look differently in each state where Bhunaksha is implemented. It is a custom                
report and requirements are incorporated during customization of Bhunaksha for the state. 
 
For printing map reports from browser it loads the report in an applet. So the browser should                 
have JRE7 plug-in installed with necessary permissions to use network and printer. The applet              
is signed by a certificate. The certificates will have to be imported to JRE path from java control                  
panel. Applet is used for map printing because there will be scaling & clarity issues if report is                  
directly printed from browser. The report in applet and desktop client uses vector printing for               
better clarity. 

 
(Default Plot Report) 
 
By default plot will be printed in an A4 size paper with best fit scale. In the report window it is                     
possible to generate the report to any scale. It is possible to overlay layers on top the plot. It is                    
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possible to generate report of all plots of a particular owner. In such case it will generate report                  
of each plot in different pages. 

 
(A customized plot report) 
 
 
 

12. Village Map Printing 
  

12.1 Village Map Printing 
 
Bhunaksha has a module for generating map of a village or sheet in printable form. The report                 
can be generated in best fit scale or to a specified scale. It is possible to overlay plot number                   
and other layers on the village map. The report can be generated for A4, A1 or A0 size paper                   
and can be printed using plotter. 
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(Village Map with selected Layers on it) 
 
Bhunaksha performs a vector printing for clarity of village map. 

12.2 Customized Village Map for States  
  

    12.2.1 Maharashtra 
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This Village map print report is customized for state maharashtra.This village map having all the               
the functionality of default village map with some extra functionality like. 

2. Search Option:- we can search the following attributes in map by entering the following              
value in text boxes . 

d. Survey Number 
e. Hissa Number 
f. M.R Number 

3. Search Result :- The village map contains the search attributes appear in search result              
Table. Select any row in Search Result Table then cilck on “Show Report ” button to view                 
the village map report. 

Example: See the above figure we enter the attribute “Survey No. ” 110 then click on “Search                 
Button” Village list appear in search result table.select any row in search result table then cilck                
on “Show report” button to view the village map report. 
 

13. Splitting Plot (Mutation) 
 
A plot can be split into any number of subdivisions. Splitting is done by creating division line.                 
There are a number of methods for creating division line. A background grid can be used to help                  
in creating division line. The angle and length of the division line will be displayed on the fly. 
The following different methods are available for creating division lines. 

1. Free hand drawing (Background grid can be used as a help)  
2. Distance and angle method 
3. Arc method 
4. Straight line method for joining two sides 
5. Methods based on area fractions (for almost rectangular plots) 
6. Point measurement method 
7. Division with help of grid and background image 

After division history of divided plot is saved for reference purpose. Divisions made can be               
temporarily saved and forwarded to higher level user for approval. The levels can be              
customized through setup module. 
Users and groups in Bhu-Naksha are the same users in ROR application. Bhu-Naksha uses the               
same ROR user tables for logging into software. 
An ROR user group can acquire four levels of permission which includes Approve , Edit , Print &                  
view permissions. The groups to whom such permission is to be granted can be customized in                
application settings module. The whole process will help in maintaining same work flow in both               
ROR application and Bhu-Naksha. 
A sample workflow which can be achieved through bhunaksha after proper setup is depicted in               
below diagram. 
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Plot division module is available in both browser client and desktop client of Bhunaksha.  

 
 

13.1 Division Tool Set 

 
Highlight vertices 

 
Remove Vertex highlighting 
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Place Grid. 
(Select this icon and click on map to place         
grid centering the clicked position)  

 
Rotate grid clockwise 

 
Rotate grid anti clockwise 

 
Remove Grid 

 
Draw Line  
(Select this icon and click on map to select         
points of division line line. This is a free         
hand drawing tool) 
 

 
Finish a line.  
(If the line touches two border of plot it will          
automatically complete the division line.     
This is useful if hole is to be cut or when a            
line is to be completed without touching       
two borders of the plot) 

 
Add a new point to a line  
(Click on the line after clicking this icon)  

Drag point of a line 
(Click this icon and start dragging any point        
of already created line) 

 
Delete a point from a line 
(Click this icon and click on any point on         
created division line to remove the point) 

 
Delete Line 
(Click this icon and click on any division        
line to remove it) 

 
Distance Angle method 
  

Distance Direction Method 

 
Arc Method (For adjacent sides ) 
  

Arc method (For opposite sides) 
 

 
Point measurement method.  
(​Each point of the line can be created by         
taking measurement from 2 known points      
on the plot​) 
 

 
Tool for measuring distance. 
 

 Area Division 
(​Divide the plot into fraction of its total area 
or extract sub parcel of a particular area 
from plot​) 

 Place Image in Background 
(​Place a scanned image of the division 
worked out on paper as background to 
help in dividing plot​) 

 Put Up for Approval 
(This will be visible for the users who has         
permission to forward a division) 

 Approve 
(This will be visible for the users who has         
permission to approve a division) 

 List of divisions pending for approval 
(This will be visible for the users who has         
permission to approve a division) 

 List of un-approved (discarded)    
divisions 
(This will be visible for the users who has         
permission to forward a division) 
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13.2 Free Hand Drawing 
 
Freehand drawing tool helps to create a division line by clicking on the map to identify the points                  
of division line. A background grid can be used to correlate with paper map while creating the                 
division line. While drawing the line it displays distance and angle with respect to an imaginary                
line pointing to east. Points can be added or deleted at any time after creating the line. The line                   
can be adjusted by dragging any point on the line.  
 

 

 
 
 

13.3 Distance Angle Method 
 
This method can be used to create a division line by specifying distance and angle of each point                  
on the line with respect to some known reference points. The line can either start and end on                  
any border of the plot or it can be inside the plot. Distance has to be mentioned with respect to                    
ground measurements.  
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13.4 Distance Direction Method 
 
This method can be used to create a division line by specifying distance and direction of each                 
point on the line with respect to some known reference points. The line can either start and end                  
on any border of the plot or it can be inside the plot. Distance has to be mentioned with respect                    
to ground measurements.  
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13.5 Arc Method (Adjacent Side) 
 
This method can be used for creating division line at a corner of a plot. Two end points of the                    
line can be identified by specifying distance from the corner point. This method will also allow us                 
to specify a third point on the line as intersection of two arcs of specific radius from the end                   
points.  

 
In the above example V1 is the corner point. First end of the division line (A1) is at a distance of                     
12 meters from V1 towards the top (towards V14). End point of the line (A3) is 15 meters                  
towards the lower base end of the plot. Arc radius is 10 meters from A1 and 14 meters from A3.                    
If there are two intersecting points inside the plot we will be able to choose one from the                  
combobox.  
 

13.6 Arc Method (Opposite Side) 
 
This method can be used for creating division line between two sides of a plot. Two end points                  
of the line can be identified by specifying distance from two known points. This method will also                 
allow us to specify a third point on the line as intersection of two arcs of specific radius from the                    
end points. 
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First end of the division line (A1) is at a distance of 5 meters from V5 towards V6. Last point of                     
the line (A3) is 6 meters towards V13 from V14. A1 and A3 will act as arc center for the third                     
point at middle of the line. Arc radius is 20 meters from A1 and 30 meters from A3. There are                    
two intersecting points P1 and P2 we selected P2 which will become A2 of the line.  
 
 

13.7 Point Measurement Method 
 
This method can be used for creating complex division lines accurately. Each point of the               
division line can be identified by measuring it from two known points. This is a more complex                 
version of the arc method where more than one points can be created by intersecting arcs. The                 
line can start either from border of the plot or can be inside the plot. This can be used for cutting                     
hole inside the plot.  
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13.8 Straight Line Division 
 
This is not a separate division method. All the division methods can be used for making straight                 
line division by specifying first point and last points on the border of plot and skipping all                 
intermediate points. Image below shows how arc method can be used for making straight line.               
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13.9 Area Division 
 
A plot can be divided considering its area and area of the subdivision parcels. Two types of area 
based divisions are possible. (a) Sub divisions can be extracted from a plot as ratio of its 
existing area. (b) Sub divisions of some particular area of interest can be extracted from the 
plot. In both cases the division can be performed either vertically, horizontally, diagonally or in 
the four corners of the rectangle enveloping the original plot.  

 
If Area value option is selected type the area of interest required for the new subdivision. If area 
fraction option i selected input a raction like ½, ¼ etc. 
After selecting the appropriate options from window as explained in the above figure, click ​Try 
Division ​button to view the division line. 

 
 
Click OK Button to confirm the division. 
 

13.10 Division with help of background image 
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In most states initially the maps were created by digitizing existing paper maps. At this time                
users had better experience in creating subdivision in paper maps compared to digitized map in               
computer. In Bhunaksha it is possible to align the image of a division made on paper in                 
background of the digitized parcel. Afterwards the same division scenario can be replicated with              
the digitized map.  
 
For aligning the image at the background the image will have to be geo-referenced with respect                
to the parcel map. The georeferencing option available in Bhunaksha is to identify some              
common points in both the map and image. The image will be transformed based on the                
identified points. The accuracy of alignment will be directly proportional to the accuracy and              
number of identified points.  
 
Click the icon to popup the window and browse the image to be placed in background. The left                  
pane of the screen will show the digitized parcel and right portion will show the selected image.                 
Next step is to identify some points of the digitized parcel. The same points will be placed in the                   
image also. The location of the corresponding points in the image can be adjusted by dragging                
the points in the image. The points can be identified on digitized map by clicking on the map.                  
Mouse will snap to existing vertices of the plot while moving mouse to click the point. This will                  
help in identifying points like corner of the plot. It is also possible to highlight all vertices of the                   
plot and adjust them on the image. 
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Once the points are getting adjusted on image it will show a preview of the. background image                 
on the left part. Click OK to project the image to the original division screen. This will show the                   
image aligned in the division window.  
 
Free hand division can be used to replicate the division lines. 
 

 
 
 

13.11 Division using ETS Data 
 
The division of plot can be done using the ETS data in this method.The ETS data in the csv 
format is imported by clicking on the browse button and is available during the division of the 
plot.These points can be used to divide the plot using other division methods. 
 
The images below illustrates how ETS data is imported and used to create the division line. 
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14. Multiple Plot Splitting (Cutting Road/Canal) 
 
Cutting a road in the village map is an example of multiple plot division. During such process the                  
portion of the road will be extracted from the existing plots. Sometimes this kind of process will                 
divide some plots into two or more disconnected parcels. The disconnected parcels will have to               
be identified by the same plot number. We should utilize vertices of existing plots in the map                 
when the new parcel will have to touch the border an existing plot to maintain clean topology. If                  
the existing boundaries are not considered with all includable vertices then the operation can              
result in narrow gap between boundary of the affected parcels and new parcel created.  
 
Bhunaksha has the facility to cut out one or more parcels from area of existing plots in a village                   
map. The new parcel can be extracted by joining a group of points identified in the village map.                  
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The points can be either vertices of existing plots or they can be created afresh in the map. New                   
points can be created by clicking in the map or by specifying distance from two known points.                 
The known points are either existing vertex or any point layer like bijunction or trijunction point.  
 

 
 
The steps involved in multiple plot division are the following. 
 
1. Select the map of the village and navigate to the area where the new parcel is to be carved                    
out. 
 
2. If the new parcel touches the border of any existing plot or vertices of any of the existing plots                    
are to be considered during division then highlight the vertices of the plots. To highlight the                

vertices select the highlight vertices tool ( ) from tool bar and click on the plot.  
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3. Create any extra points needed for carving out new parcel. New points can be created by                 

clicking on the map after selecting “Click to Insert Point tool” ( ) From tool bar. When this tool                  
is used for creating a point it will show the distance and angle with respect to the previously                  
created point to the new point being created.  

 
 
A new point can also be created by specifying its distance from two known points. The                
intersection of the arc radius as specified distance from the known points will be treated as new                 
point. The known points can be any of the highlighted vertices, any new points created or a                 
point layer like bi-junction, tri-junction.  
 
To create a point using the above mentioned procedure, select the tool “Insert Point              

(Measurement Based)” ( ).  
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The tool will prompt for two known       
points and its distances to the new       
point being created.Name of the known      
points can be typed in the respective       
boxes or they can be picked from the        
map using the tool adjacent to the input        
boxes. Click the Add button after      
verifying the point. 

 

 
4. Join the points to carve out new parcel. Points can be joined by clicking on the points after                   
selecting the “Join Points Tool” ( ) or by inputting the name of the points in respective fields                 
after selecting tool ( ). Make sure to select all points on the boundary of the plots if that                  
boundary is part of the new parcel being cut. Leaving some points in the boundary will result in                  
narrow unnoticed polygon left out in the map. Starting point and end point of the parcel being                 
carved out should be the same. Once the points of the new polygon is completely identified, it                 
will highlight the area of new plot being carved out and the remaining area of older existing                 
plots. It is possible that some of the older plots may have got mutated into two or more                  
disconnected portions. This will happen if the road goes through middle of some plots. The               
disconnected portions of the existing plot will have same plot number.  
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Once the new parcel is carved out the details of affected plots and new parcel will be shown in                   
the left pane.  
 

 
The details of affected plots will be shown in 
Divided Plots tab. 

 
The new parcel carved out will be shown in 
Created Layer tab. It is possible to assign plot 
number and layer type of the new parcel from 
this table. 
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5. Assign plot number and layer code to the newly carved out area. This can be done in the                   
Created Layer tab in left pane as shown in above figure. Once the layer type is selected new                  
new area will be shown with the actual style of the layer (eg: style of Road).  
 

 
 
The above process can be repeated for any number of new parcel being carved out from the                 
map.  
 

6. Save the changes ( ) 
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15. Merging plots 
 
Bhunaksha has a module for merging one or more plots in a village. A user can merge upto 12                   
khasra’s  through this module and assign a new khasra number to the newly created plot. 
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16. Creating map using FMB and Tippon 
 
Maps can be created interactively from FMB (Field Measurement Book) data and tippon sketch.              
Once the map is created it will be similar to any other map in Bhunaksha. 
 
Select the village and other details for which you are creating the map. The details being                
selected will differ from state to state based on the customization performed for the state. 
 

 
 
If data already exists for the details entered then it will show the existing map and layers. You                  
will be able to add new offset points and subdivision on the existing map. 
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16.1 Diagonal and Offset / Simple Triangulation System. 
 

Draw Base Line.  
 
 

Once you click the draw base line option you will be           
prompted with options for name of base line points and          
length of the line.  
Enter the start point name and end point name and length           
of the line. Click Insert and start drawing the line on the            
map area.  
You can start with any G line from the sketch. 
 
Click the start position and adjust and click the end position           
in such a way that the angle of the line matches with the             
sketch. 
  

 

After clicking the first point when you move mouse in the           
map area it will show the position of second point on the            
direction of mouse position. Click to accept the angle and          
position of second point. 

 

 
 

Draw Triangle  
 
Click the draw triangle icon to build triangulation on the base line.  
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1) Select the base line. 
2) Enter name of the third point of triangle. 
3) Enter the distances from two points of the         
selected baseline to third point of the triangle. 
4) Select the position of the third point. 
5) Click OK to draw the triangle. 

                       

Continue the above steps until you build the triangulation that are in the sketch. 

 
 

Create Offset Points.  
 
 

 

Select first and last point of the line on which          
you want to create offset points.  
Click on the ‘select point’ button and select        
each points. Click OK to start adding offset        
points.  
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Once you click OK button the line will be added to the ladder table. You can enter ladder data                   
corresponding to the offset points. Ladder data should be entered from bottom to top. On               
pressing enter key after feeding each row of ladder data it will insert a new row above the                  
current row and focus will transfer to the newly created row. The offset points and its distance                 
line will automatically appear in the map once you start entering the ladder data. 
 

 
 

 
 
Add offset point on other lines also as required. 
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You can also add offset points on an extended base line. Extended line are base lines which                 
has two offset points as it’s terminal points. To create an extended base line follow the same                 
procedure as above but select the start and end point as points which are offset points created                 
earlier.  
 

 

 

In the above figure offset points 18 and 19 are placed on the line from 13 to 10 which are offset                     
points created earlier. 
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 ​Join Boundary  
 
To create boundary polygon select the tool and click on the created points in the order they                 
should appear in the boundary. The polygon created will be added to the polygons table once it                 
is drawn. The polygons table will show the polygons created, its area and label (plot number).                
The plot number can be assigned from this table. 
 
 

 

 

 
 

Create Sub division.  
 
Subdivision can be created after creating the boundary polygon. To create sub division select              
the tool and click on the points in a series. The subdivision will automatically appear in the                 
polygon table once the line created by clicking the series of points will contribute to a valid sub                  
polygon of the boundary polygon. You can assign the number to the newly created sub division. 
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It is also possible to create sub division without touching the boundary of the existing polygons.  
 

 

 

 
 

 ​Insert Point Layer 
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You can insert point layers to the map using this tool. Code, name and appearance of point                 
layers can be defined in Manage Layer option as described above. On selecting this tool you                
will be able to select the layer from list of already defined layers. You will also be able to enter                    
label and other properties of the layer being inserted. There is no limit on the number of layers                  
that can be defined. The appearance of layer can be made robust by using SLD styles and                 
symbols. 
 
 

  
After clicking the Insert button the pointer can be moved to the proper place where the layer is                  
to be inserted. The actual layer will be following the mouse pointer once you start moving                
mouse in the map area after clicking insert button. You can click on the map to insert the layer                   
at the mouse position. Point layer can be snapped to already existing points. Already existing               
points will be highlighted when mouse is moved around them.  
 
It is also possible to define layer attributes which can contribute to style of individual layer. For                 
example it is possible to define attributes like rotation and font size for a text layer while defining                  
the layer. The same can be made part of SLD style. The values for these attributes can be                  
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assigned to individual layers while inserting them in map. This is how highly dynamic styling of                
individual layers can be achieved in Bhunaksha. 
 

 
 
The inserted point layers will appear in Points table. 
 

Insert Line Layer 
 
Line layer can also be drawn on the map using this tool. As in point layer tool here also we can                     
select the layer from the list of already defined layers. Since Bhunaksha utilize the robustness of                
SLD styles there is no limit on styles that can be defined for a layer. After selecting the layer to                    
be inserted click Insert button and click on the map to start drawing the layer. You can click                  
wherever there is a deviation in the line layer. Double click to complete the line layer. 
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Insert Polygon Layer 
 
The process of inserting polygon layer is also almost similar to process of inserting point layer                
and line layer. Select the polygon layer you have already defined, click insert button and start                
drawing the layer in map. Click on the map to identify each vertex of the polygon layer. Double                  
click to complete the layer. 
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16.2 Bombay Style  
 
The procedure for creating base line in Bombay style is almost similar to the process defined                
above. In Bombay style there may not be any proper triangle involved. Offset points can be                
entered on a single base line, extended line and hanging base line. 
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Hanging Base Line 
 
Use this option to create a hanging base line.  
 

 

1. Select first and last point from which the         
hanging baseline is to be drawn. These may        
be two offset points. 
2. Enter distance from the selected two points        
to the hanging base line. 
3. Enter name of points on hanging base line. 
4. Select the hanging base line from the list of          
options which meet the entered criteria.  
5. Click OK  
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After clicking the OK button the hanging base line will be drawn on screen. You can start                 
creating offset points on the hanging base line. 

 
 

16.3 Viewing/ Printing Map created from FMB. 
 
Maps created by FMB are quite similar to maps created by other methods like importing from                
shape file. Base line and offset points will be shown as derived layer. 
The map and its layers will be available in all display, printing and export modules of Bhunaksha                 
in both browser and desktop client. 
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17. Composing Survey Data 
 
Data extracted from ETS can be imported to Bhunaksha and processed further to build village 
map and other layers. Bhunaksha supports ETS data in LandXML (​http://www.landxml.org​)  and 
comma separated value (CSV) of coordinate points.  For processing survey data open 
Compose Survey Data module from File menu. 
 

LandXml and CSV coordinate points can be imported to the screen by using Import Data ( ) 
tool bar icon.  

 
 
Select file format and browse the data file. It will show a summary of points or parcels present in 
the data. Click OK to further process the data.  
The left panel of the screen has village selection control and a section to view and manage the 
points, plots and layers. Points tab shows coordinates of each point present in the survey. Poly 
Layers tab lists parcels and other polygon layers. Ln Layers and Pt Layers tab lists line and 
point layers.  
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A plot or parcel can be created by using the Create Parcel ( ) tool. After selecting this tool 
you can draw a parcel by joining the points present in the field. The parcels created will be listed 
in the Poly Layers table. A plot number can be assigned to the parcel by editing the Label field 
in the table.  
It is possible to insert other Polygon, Line and Point layers by similar method described for FMB  

18. Plot Comparison Reports  
 
Bhunaksha has reports for comparing plot numbers present in map and ROR (Textual) data.  
It is possible to generate report of plots present in map and missing in ROR, present in ROR                  
and missing in map and duplicate plots in map. 

18.1  Plots Present in map missing in ROR 
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18.2 Plots Present in ROR missing in Map 
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18.3 Duplicate Plot numbers in map 
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19. Mutation Report 
 
Bhunaksha has report for displaying all the divisions/Mutations done in a village. It is possible to                
generate report for all the mutations done in a village. Options for filtering report data is also                 
there. User can filter the data according to UserName and date. User can also view the image                 
of the actual plot and divided plot in the report. 
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(Mutation Report without Map) 
 
 

 
(Mutation Report with Map) 
 
 

20. Export Map as Shape file 
 
Bhunaksha export module is intended for exporting geometry and attribute data from bhunaksha             
database to shape files. 
There are mainly two modules for exporting shape files from bhunaksha 
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20.1 Bulk Export 
 
Bulk Export option can be used for exporting a set of village’s geometry and attribute in a single                  
go. For using this module login into Desktop application as user and invoke the option from File                 
-> Bulk Export.  
 

 

 

20.2 Individual Export 
 
Plot and layer geometry and attributes can be exported individually from bhunaksha if naming              
pattern used for shape files does not support the bulk export standards. Individual files can be                
exported from the following options. 
 

18.2.1  Export Plots (SHP) 
 
This module can be used for exporting plot shape file. 
 

1. Select the village for which data is to be exported 
2. Select the check boxes as per requirements for exporting. 
3. Browse the destination folder for saving the exported files. 
4. Click export to export the bhunaksha geometry and attribute data  to shape file. 
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21. Embedding Plot Map in ROR report. 
 
It is possible to request map of a plot to any specified scale by providing parameters. The 
resulting map image output can be used to embed in ROR reports.  
A sample URL for requesting plot map is as follows.  
 
http://<server>/<bhunakshapath>/PlotImage?state=02&giscode=0612000101&plotno=123&heig
ht=700&width=700&scale=600&layerCodes=POLY_PARCEL,RI 
 
Please consider actual server, state code etc in the above example. 
 
The following parameters are acceptable. 
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state = state code. 
giscode = districtcode-tehsilcode-villagecode (This can be different in different states) Like           
(06-District code,12-Tehsil code,000101-Village code) 
plotno=plot number 
scale= (Optional) scale of map. eg: scale=4000 gives image in 1:4000 scale.  
If scale is blank it will fit the map in size of image. 
height = image height. 
width = image width. 
layerCodes = Comma separated list of  Layer Codes 
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22. Audit Trail  
 
Audit trail is available as activity log in Bhunaksha. The activity log gets an entry when a user                  
logs in, starts a division and put up for approval, when a higher user approves the division. It                  
has listing of time, user who performed the operation and description of operation. Plot number               
on which the operation is performed is part of description. 

 
 

23. Plot Info 
 
Bhunaksha Plot info module can be used for viewing all the details of the plots in addition to the                   
owner and area details vertices distance details is also available in this module. 

 
(Plot info Desktop View) 
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(Plot Info Web View) 
 

24. Imported Villages Report 
 
Bhunaksha has a report for displaying all the imported villages in the bhunaksha database. In               
the report all the details of imported sheet numbers and total no of plots in the village is                  
displayed. 
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25. Data Transfer to server 
 
If Bhunaksha is running in a distributed environment then data can be exported to web 
application installed on a central server. 

 
 
Type the URL of Bhunaksha web application server and click Transfer button after logging in as 
a valid user in Bhunaksha Desktop Application to perform data transfer. 
 

26. Unimported Villages Report 
In addition to Imported villages report Bhunaksha has a report for displaying all the unimported               
villages. In this report all the villages whose data is present in ROR but not in bhunaksha                 
database are displayed. 
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27. Data Migration from previous version 
 
There is significant change in database structure of Bhunakhas 3.0 from that of previous 
versions. Customized data migration modules are available for states where Bhunaksha 2.0 
was in use. Data can be migrated from database of a Desktop version of old Bhunaksha. 
Double click the launcher for data migration for your state to invoke data migration module. 
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The system where data migration module is invoked should have permission to connect to old               
and new database. New database can be created and initialized from the Migration module              
itself. After providing connection parameters for both old version and new version click the              
Migrate button to start data migration. 
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28. Georeferencing Village Maps 
 
It is possible to georeference a village map with the help of village boundary layers from NIC                 
Maps (​http://nicmaps.rsgis.nic.in/​) and other online services offered by Bing, Google, Bhuvan           
etc. Onscreen georeferencing is possible my correlating some known coordinates of digitized            
map with the coordinates of georeferenced maps. Identifying a minimum of four such points              
will facilitate transforming the coordinate system to world coordinate system. Accuracy will            
depend on the accuracy and number of the known coordinates. 
 

 

 

29. Custom Services 
 

29.1  Himachal Pradesh 
Custom services are available for GIS data from Settlement and Consolidation maps of the 
state. For accessing the services the following parameters has to be configured in application 
settings for connecting to respective databases.  

1. Host name for settlement map database:  IP address of DB server 
2. Port number for settlement map database: Port no. of settlement DB 
3. Database name for settlement map database: Name of settlement DB 
4. Database User for settlement map database: User name of settlement DB 
5. Database password for settlement map database: Password of settlement DB 
6. host name for consolidation map database: IP address of DB server  
7. Port number for consolidation map database: Port no. of Consolidation DB 
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8. Database name for consolidation map database: Name of consolidation DB 
9. Database user for consolidation map database: User name of Consolidation DB 
10. Database password for consolidation map database: Password of Consolidation DB  

 

29.1.1   PlotImage Service 
 

The PlotImageService is used to access plot image either for consolidation database or 
settlement database or main database. You would be required to pass four parameters in the 
URL to access the service as…  

1. State Code 
2. GIS code 
3. Plot No. 
4. Map Type 

 
In Map Type, pass a character as ‘C’ for Consolidation map, ‘S’ for Settlement map and L or 
blank character for main map.  
 
To access this service kindly use the URL as prescribed below… 
 
http://localhost:8080/bhunakshaweb3/rest/PlotImage?state=02&giscode=0612000701&plotno=1
8&mapType=C  
 
You would be able to get plot image using this URL if the detail is passed correctly, as shown in 
the below image …  
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29.1.2  Neigboring Plots 
 
This NeighbourPlotsservice is used to access the details of neighbours plots either for main 
database or consolidation database or settlement database. It would also be required to pass 
four parameter in the URL to access the service as  

1. State Code 
2. GIS code  
3. Plot No.  
4. Map Type  

 
In Map Type pass a character as ‘C’ representing Consolidation neighbour detail, ‘S’ for 
Settlement detail and any other character for main database detail.  
To check this service kindly use the URL given below … 
 
http://localhost:8080/bhunakshaweb3/rest/getNeighboursPlots?state=02&giscode=0612000701
&plotno=18&mapType=C  
 
You would be able to get neighbours plot detail using this URL if the detail is passed correctly, 
as shown in the below image …  
 

 
 
 

30. Bhunaksha Mobile App 
 
Bhunaksha mobile app is available for android mobiles. It supports viewing village map and              
plot details online, viewing plot report offline, saving village map and plot report for offline               
operation, updating comments of any selected plot. 
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Home Screen 
 

  

 
From home screen we can navigate to the available modules in the application. A swipeable               
context menu is also available for navigating to the modules from any screen. Menu can be                

opened by touching the context icon ( ). 
 
 
Settings 
 
Settings option can be opened from the context menu. It is possible to save server URL of                 
bhunaksha in settings menu. When the server URL is setup correctly, you will be able to view                 
maps from that server in the mobile application.  
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If server is available then the Online Switch in the menu will be on. You can go offline any 
time by switching off it from the menu.  

 
 
 
 
Viewing Village Map 
 
Bhunaksha mobile application can display online village map when connection to server is             
available. Village can be selected from the select box on left context menu. In online mode it                 

is possible to select a plot either by touching it on the map or by searching ( ) the plot on                    
the top bar of the app screen. When the plot is selected it will popup the owner and area                   
details of the plot. It is possible to view a detailed map report of the selected plot by                  

touching report icon ( ) from the popup. It is also possible to update a comment ( )                

about the plot and save it to the server. Village map data can be downloaded( ) for offline                 
purpose from this screen. Village map data stored offline will use storage space of the               
mobile.  
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Online Village Map 

 
Offline Village Map 

 
 
 
 
Offline village maps can be viewed from the saved village map list or when the Online Switch 
is off. In offline mode it is possible to select a plot, search a plot, view owner and area 
details, and save a comment about the selected plot. The comment can be updated to server 
on going online.  
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Plot Report 
 

Detailed plot report can be viewed online by touching report icon ( ) from village map 
screen.  
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It is possible save a report for offline purpose by touching download ( ) icon.  
 
 
 
Saved Village List 
 
List of villages for which offline maps are available can be viewed from the respective options                
in menu and home screen. Map of a village can be viewed by selecting the respective row                 
from the list. Data of a saved village can be deleted by touching  

delete ( ) button.  
 

 
 
 
 
Saved Plot Report List 
 
List of offline plot reports can be viewed by invoking the respective options in menu or home 
screen. Report can be viewed by selecting the respective row from the list. A saved report 

can be deleted by touching the delete( ) icon.  It is also possible to view a report of a 
plot online from this screen if connection is available to bhunaksha server.  
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Saved Comments List 
 
List of comments stored offline can be viewed  by invoking the respective options in menu or 
home screen. It is possible to delete a comment and update the comments to server from this 
screen.  
 

  
 

 
 
 

31. Bhunaksha FAQ 
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1. Why map is too small or too large compared to original map sheet when the same                
scale is applied 

2. Why line lengths of some lines shown in Bhunaksha differs significantly with            
actual ground measures 
 
By default Bhunaksha assumes 1 unit of measurement in the imported shape file is              
equal to 1 meter on ground. This assumption can be wrong if digitization was not               
performed with the same parameters. In such cases it is possible to input a scale factor                
of the map while importing it to Bhunaksha. Scale factor is the ratio ratio of actual                
digitized meters in meters. For eg: if i unit in digitized unit is equal to 1 inch on ground                   
then scale factor should be 0.0254 (1 inch = 0.0254 meter). 

 
 

3. Why There is a slight difference in print out taken in Bhunaksha and original sheet               
map. 
 
Bhunaksha rely on the digitized data. It will match properly to the scaled print out taken                
from digitized data in any GIS software. Proper quality check like glass table test must               
be performed during digitization to ensure matching of original sheet map and digitized             
data. 
 

4. What is self-intersection error? How to rectify them? 
Open Geospatial Consortium (OGC) standard specifies and a valid Polygon must           
confine the following criteria: 
 

● Polygon rings must close. 
● Rings that define holes should be inside rings that define exterior boundaries. 
● Rings may not self-intersect (they may neither touch nor cross one another). 
● Rings may not touch other rings, except at a point. 

 
The reason the rules are important is because algorithms for geometry calculations            
depend on consistent structure in the inputs. It is possible to build algorithms that have               
no structural assumptions, but those routines tend to be very slow. 
 
Example of an invalid polygon: 
 
POLYGON((0 0, 0 1, 2 1, 2 2, 1 2, 1 0, 0 0)); 
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The outer ring is actually a figure-eight, with a self-intersection in the middle. Note that               
the graphic routines successfully render the polygon fill, so that visually it is appears to               
be an “area”: two one-unit squares, so a total area of two units of area. Most GIS                 
applications pertaining to OGC standard will report its area as 0 because algorithm that              
calculates area assumes that rings to not self-intersect. 
 
A valid representation of the above geometry is :  
MULTIPOLYGON( 
  ((0 0,0 1,1 1,1 0,0 0)), 
  ((1 1,1 2,2 2,2 1,1 1)) 
) 

  
 
Lets take another example a classic invalidity – the “banana polygon” – a single ring that                
encloses an area but bends around to touch itself, leaving a “hole” which is not actually a                 
hole. 
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A valid representation of the above geometry is: 

 
POLYGON((0 0,0 4,4 4,4 0,2 0,0 0),(2 0,3 1,2 2,1 1,2 0)) 

 
Polygons must be made valid while building the topology and correcting topological errors             
during digitization. Some of the errors cannot be corrected by any automated routines.  
 
Some of the self-intersection errors like banana polygon in shape file can be corrected in               
Bhunaksha (Refer section : 8.Viewing and Correcting Shape files)  
 

5.  
 
  

32 Annexure  
 

32.1 Installation of Postgresql & Postgis 
 

32.1.1 On Ubuntu 14.04 LTS. 
 

1) Open terminal and install required packages. 
 
sudo apt-get install postgresql postgresql-contrib postgis postgresql-9.3-postgis-2.1 
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Please verify the name of packages as per version of your OS. 
 

2) Creating postgis template database. 
 
In terminal type the following commands: 
 
sudo su - postgres 
(Provide OS administrator user password) 
createdb postgis 
psql -d postgis -c "CREATE EXTENSION postgis;" 
psql -d postgis -c "CREATE EXTENSION postgis_topology;" 
 

3) After this you can create database for Bhunaksha using template postgis 
 

32.1.2 On Windows 
 

Postgres Installation 
 

1. Go to Postgres windows download page and download “One click installer for Postgres”. 
2. Run the .exe that has been downloaded to install Postgres. 
3. All the normal settings should be “ok” click next to accept all the default settings. 
4. Enter the password when prompted. 
5. Make sure the "Launch Stack Builder at exist?" box is ​unchecked ​and clicks finish. 

 

PostGis Installation 
 

1. Download the postgis .exe(​ ​http://download.osgeo.org/postgis/windows/pg92/​ ) 
2. Run the .exe that has been downloaded to install postgis. 
3. Check “create spatial database” when prompted and click next. 
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4. All the normal settings should be “OK” click next to accept all the default settings. 
5. Enter Postgres password when prompted. 
6. Provide the default postgis template name (“Postgis as default template name is 

recommended”) and click next. 

7. During installation following message may appear. click “YES” for it.
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32.2 Load balancing and High availability Clustering setup for Tomcat  
 
Clustering allows us to run an application on several parallel servers (a.k.a cluster nodes). The               
load is distributed across different servers, and even if any of the servers fails, the application is                 
still accessible via other cluster nodes. Clustering is crucial for scalable enterprise applications,             
as you can improve performance by simply adding more nodes to the cluster. 
 
Clustering solutions usually provide: 

● Scalability 
As load increases gradually, the system should allow to reduce response time by             
increasing computing resources and number of servers. 

● High Availability 
If one server in the cluster goes down, then other servers in the cluster should be able to                  
take over -- as transparently to the end user as possible. 

● Load Balancing 
The objective here is that the solution should distribute the load among the servers in the                
cluster to provide the best possible response time to the end user. 
In a typical clustering solution, this involves use of a load distribution algorithm, like a               
simple round robin algorithm or more sophisticated algorithms, that distributes requests           
to the servers in the cluster by keeping track of the load and available resources on the                 
servers. 

 
The below figure depicts an overview diagram of a clustered setup. Application (Bhunakha) will              
be installed in tomcat servers on as many nodes as possible. All requests from users will be                 
routed through the apache server. The apache server will forward the requests to tomcat              
servers. For reference we will name the apache server as ​balancer1 and tomcat servers as               
tomcat1, tomcat2, tomcatn ​etc. The names in the procedure can be replaced by their domain               
names or IP address while setting up the environment.  
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This procedure describes setting up the environment in Ubuntu Linux servers using Apache and 
memcached session manager. This step also sets up sticky session ie. if user begins session 
with Tomcat 1, he would be served by Tomcat 1 throughout the entire session, unless of course 
this instance goes down. This can be beneficial in a clustered environment, as application 
servers can use session data stored locally without contacting a remote memcached. If Tomcat 
1 fails further requests will be forwarded to new server Tomcat 2 along with its session from 
memcached session manager.  
 
Setting up tomcat server 
 
All all the servers install Oracle Java and tomcat7. Make sure to install the same version of both.  
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The jar files to be downloaded are available on this link 
http://code.google.com/p/memcached-session-manager/downloads/list 
For each copy, download the following jars and install them to the tomcat_dir/lib directory: 

● memcached-session-manager-x.y.z.jar 
● memcached-session-manager-tc7-x.y.z.jar​ (for Tomcat 7) 
● spymemcached-x.y.z.jar​, 
● msm-javolution-serializer-x.y.z.jar 
● javolution-a.b.c.jar​ (Consider latest available version) 

 
On each server, open conf/context.xml, and add the following lines inside the <Context> tag: 
 
<Manager className="de.javakaffee.web.msm.MemcachedBackupSessionManager" 
    memcachedNodes="n1:​balancer1​:11211" 
    requestUriIgnorePattern=".*\.(ico|png|gif|jpg|css|js)$" 
transcoderFactoryClass="de.javakaffee.web.msm.serializer.javolution.JavolutionTranscoderFact
ory" /> 
 
Replace ​balancer1​ ​with domain name or IP address of apache server. 11211 is the default port 
on which memcached listen. n1 is a key used for identifying memcached session manager. If 
more than one session manager is used parallely they can be typed separated by comma.  In 
this way the session manager also can be load balanced. 
 
Open tomcat_dir/conf/server.xml, look for the following lines: 
<Server port="8005" ...> 
    ... 
    <Connector port="8080" protocol="HTTP/1.1" ...> 
    ... 
    <Connector port="8009" protocol="AJP/1.3" ...> 
 
This is optional, but we can disable the HTTP/1.1 connector by commenting out its <Connector> 
tag, as the setup documented here only requires the AJP connector to be enabled. 
 
Finally, look for this line, also in tomcat_dir/conf/server.xml: 
 
<Engine name="Catalina" defaultHost="localhost" ...> 
 
Add the jvmRoute property, and assign it a value, that is different between the two installations. 
For example: 
<Engine name="Catalina" defaultHost="localhost" jvmRoute="jvm1" ...> 
 
And, for the second instance: 
<Engine name="Catalina" defaultHost="localhost" jvmRoute="jvm2" ...> 
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Setting up balancer 
 
Install apache server and memcached with the following commands. 
 
sudo apt-get install apache2 
 
sudo apt-get install memcached 
 
Enable required modules in apache: 
 
sudo a2enmod proxy 
sudo a2enmod proxy_ajp 
sudo a2enmod lbmethod_byrequests 
 
Open /etc/apache2/sites-available/000-default.conf  and enter the following details inside the 
VirtualHost tag. 
 
<Proxy balancer://cluster> 

BalancerMember ajp://tomcat1:8009 route=jvm1 
BalancerMember ajp://tomcat2:8009 route=jvm2 
BalancerMember ajp://tomcatn:8009 route=jvmn 

</Proxy> 
 
ProxyPass /bhunaksha/ balancer://cluster/bhunaksha/ stickysession=JSESSIONID|jsessionid 
 
Type 1 entry for each tomcat servers with proper route name as mentioned in jvmRoute attribute 
of its server.xml 
 
Restart apache and memcached. 
 
sudo service apache2 restart 
sudo service memcached restart 
 
You can access Bhunaksha application with the URL ​http://balancer1/bhunaksha 

 

33. Configuring Bhunaksha Demo application 
  
Bhunaksha Demo application has some data by default which you can view and work on for                
understanding working of Bhunaksha. Demo application can also connect to your ROR textual             
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database by configuring the connection parameters and queries for fetching details from the             
database. Once configured properly you can import shape files for your villages and have a feel                
of working Bhunaksha with your database. ​We recommend this only for demonstrating and             
learning the application. For permanent use we will customize it separately for your state by               
studying the textual data structure and workflow present in your state.​ You can provide the               
database details for connecting Textual and Vector (Bhunaksha - Postgresql) database from            
Settings -> Server Settings menu. Both the databases should have proper permissions to             
connect from the system where Desktop application is being configured. A new Bhunaksha DB              
can be created and initialized with tables and structures for running fresh Bhunaksha Demo              
application from this screen itself. Initially if you wish to work with the default data provided for                 
demo use, provide the same bhunaksha database connection parameters in both Vector and             
Non Vector database settings area. Test the connections and click OK button to save the               
connection details.  
 
Run the again Bhunaksha.exe. Fill the user  as ​admin​ and password as ​admin​. 
Changing ROR Settings-:  
 ​The ROR Settings can be  from menu Settings -> ROR Settings. 

●     ​General Settings-:  
In General Settings you can change state code ,state name, vsrlevelcount , maplevelcount etc. 
And updated it. vsrlevelcound is the number of levels present in database for navigating to 
village. For example if the levels present in database are District, Tehsil and village then this 
field should have value 3. maplevelcount is the number of levels present in map in a village. If 
you have different sheet maps for each village then it should have value 1. If village map sheets 
are mosaiced to a single shape file for each village then every village will have a one shape file 
and this field can be kept 0.  
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●      ​   ​ROR Query Settings-:​   ​In this you can configure Label for each selection level and 
setup up queries needed to fetch the selection levels and owner/area details from ROR 
database. In the queries you can use substitution variables like $level1, $level2, $vsrno, 
$plotno etc. to refer to currently selected levels and plots.  
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 ​Example: 
 Suppose we have three label as ​District​ , ​Tehsil​ and ​Village​ . Now we will 
change query  according this- 
 1-​District-: 

1.1​ ​   Label -:​ ​Suppose we have first label is ​District​. 
1.2​ ​   Query-:​  ​The query will be- select dist_code,dist_name from  dist_table. 
1.3​   ​ DB -:  ​Vector/Nonvector​. 

  
  

2-Tehsil​ ​-: 
2.1​ ​ Label -: ​Suppose we have second label is ​Tehsil​. 
2.2  Query-:  ​The query will be-select teshil_code, teshil _name from  teshil _table 
where dist_code=’$level1’. 
2.3  DB -: ​Vector/Nonvector. 

  
3- Village​ ​-: 

3.1  Label -: ​Suppose we have third label is ​Village​. 
 
3.2  Query-:  ​The query will be-select village_code, village _name from  village _table 
where dist_code=’$level1’ and teshil_code=’$level2’. 
 
3.3  DB -: ​Vector/Nonvector. 
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 After changing the ROR settings that  you can again provide the database details for 
connecting to Bhunaksha  DB in postgresql and Textual database.  
 

34. Downloads 
 
The following items can be downloaded via the File->Downloads option present in the web 
application. 
 

1. Desktop Client 
 

The Bhunaksha desktop client can be downloaded from this link.The Latest Java runtime 
has to be installed on your system to run this application.The preconfigured JRE can be 
downloaded from “http://10.1.43.239/bhunaksha” and merged with this folder structure. 
 
Whenever the web application is upgraded on the server, the desktop application 
installed on client machines will get an update automatically on the login screen. 

 
2. Fonts 
3. Bhunaksha Mobile App 
4. Certificates 

 
More Information about Java,PostgreSQL and PostGIS,Documentation and GDAL is also 
available there. 
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